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1

INTRODUCTION

The SkyeLeafv2 software has been designed and written exclusively for Skye Instruments Ltd.
It allows fast and accurate measurements of Leaf Area, Leaf Length, Breadth and Perimeter,
number of leaves and secondary, diseased or damaged areas.
Measurements can be made on individual leaves in situ or removed from the plant, or on a
large numbers of detached leaves with a statistical analysis. SkyeLeafv2 makes long,
repetitive measurements a much quicker and more accurate process.
The software can be used as a stand alone program or linked to a live video camera system
as described below. Complete system packages are available from Skye Instruments (PCs or
laptops on request only).
1. Stand alone software for the analysis of saved image files.
Post analysis of leaf images taken using a standard digital camera in the field. Files can be
analysed in situ on a laptop PC or can be analysed later in the laboratory or office. It is
important to remember to include a scaling object in each photograph.
2. Laboratory system using a PC with light box and USB video camera
Although this is a destructive method of analysis, it gives the most flexible approach for
analysis of a wide range of leaf sizes, colours and varieties. Lighting of leaves to be
analysed is fully adjustable, allowing easy determination of different colours, shades and
diseased or damaged areas on the leaves.
3. PC system with a flatbed scanner.
A standard office flatbed USB scanner can be used to capture images directly into
SkyeLeafv2 for analysis.
SkyeLeafv2 software is protected and requires an Unlock Code from Skye in order to access
full functionality. The software will automatically operate in Demo Mode unless it has been
Unlocked. Demo Mode runs for 15 minutes and will not allow the user to save any results or
connect a video camera. JPG images or photographs can be analysed to demonstrate the
features. Demo Mode may be run an unlimited number of times.
Another family member in this Skye analysis software range is SkyeRoot v2 software.
SkyeRoot v2 has similar functions to SkyeLeaf v2 but is specifically designed for the analysis
of total root length, including root branches and tips plus a feature for overlap correction in
complex root structures. Naturally, this is a destructive method only and roots should
preferably be washed and stained for optimum accuracy. Please ask Skye Instruments or
your local distributor for more details.
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2 PC REQUIREMENTS
Skyeleafv2 SOFTWARE REQUIREMENTS




PC running Windows XP Professional (Service Pack 2 or above) or Windows Vista
Professional or Windows 7 Professional
Current Windows upgrades installed
Spare USB port for video camera or scanner (if required)

NOTE – the software is designed to operate faster if the PC has a dual or quad core
microprocessor
Image Capture Requirements
Any or all of the following may be used:
 'Live’ video camera system, field or laboratory system – a USB video camera with drivers
fully installed. The camera must have DShow or Direct Show, a feature which can be
accessed directly from the SkyeLeafv2 software, without translation required from the
camera manufacturer’s own software.
 Flatbed scanner system - USB scanner with drivers fully installed
 Digital camera with PC cable or memory card reader to transfer photographs / images to
the PC
*IT IS ASSUMED THAT USERS HAVE A BASIC KNOWLEDGE OF WINDOWS*

4

SI 740 – Leaf Area & Root Analysis Software
3

SOFTWARE INSTALLATION

To install the SkyeLeaf v2 Leaf Area and Analysis software, you must be running Windows XP
Professional (Service Pack 2 or above) or Windows Vista Professional. If you do not have
current Windows updates installed then the installation process may require internet
connection to update Windows to include the .NET Framework 3.5 program installation
feature.
Insert the CD into the CD drive, the software should “autorun”. If it does not automatically
start, please open your CD browser and double click on “opening.htm”
SkyeLeaf v2 software is protected and you will require an Unlock Code from Skye in order to
complete the installation. The software will automatically operate in Demo Mode unless it has
been Unlocked. Demo Mode runs for 15 minutes and will not allow the user to save any
results or connect a video camera. JPG images or photographs can be analysed to
demonstrate the features. Demo Mode may be run an unlimited number of times.
Make a note of the Source Code given by the SkyeLeaf v2 Setup program and either
telephone, fax or email this number to Skye, with the Serial Number of your installation CD.
You will be given an Unlock Code by return to enter and allow full use of the software. (For
each installation on a different PC, a new Unlock Code is required, please see the Software
Licence Agreement at the back of this manual for details)
To start the program, click Start, All Programs, Skye Instruments and SkyeLeafv2.
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4

CAMERA INSTALLATION

Although the SkyeLeaf v2 software can be used alone, many users choose to use a “live”
video camera to capture images of leaves for analysis.
You may connect your own camera if you have one. The SkyeLeaf v2 software uses the Direct
Show or DSHOW feature of the camera, so if you are using your own camera it is essential to
check if this feature is available. The DSHOW feature must be able to be accessed directly
from the SkyeLeafv2 software, without any translation being required via the camera
manufacturer’s own software.
From time to time, camera models may change slightly and the installation instructions may
differ slightly, but the basic principle remains the same. Please follow the instructions supplied
with your camera carefully.
In some cases it will be necessary to connect to the Internet to download the most recent
installation software and drivers before starting, e.g. for the IDS Eye high-resolution camera
that can be purchased from Skye:

These two simple steps should always be followed:
1.

Do NOT connect the camera to the PC at first! It is important to install the camera software
first.
2. Connect the camera to the PC only when instructed by the installation software.
The camera will be powered directly from the PC’s USB port.
CAMERA SOFTWARE
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5

HARDWARE OPTIONS

This chapter applies only if you will be using a USB video camera with the laboratory system.
If you are using a flat-bed scanner or simply analysing previously saved image files, please
skip this Chapter and follow the Software Installation in Chapter 4.

Dimmable Light Box
Assembly
See illustrated installation instructions
Operation
1. Switch on and adjust light level using the round knob located on the front of the unit.

2. For best results minimise reflections from windows and overhead office lighting. Simply
switching off the room lights may suffice, or you may find it helpful to shade the whole
light box assembly.
3. For the analysis of low contrast disease areas (of similar colour to the main leaf) it may
be useful to add lighting from above, such as from a desk lamp.
4. Place leaves under the hinged leaf clamp to keep flat during analysis.
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6

ANALYSIS USING THE LIGHT BOX

This example shows the Laboratory System being used with an IDS Eye video camera. The
general procedure will be the same for any camera, however the individual camera settings
and controls may differ according to the camera model. The camera must be fully installed
before starting.

6.1 System Calibration
SkyeLeafv2 has two calibration options, automatic or manual. Either option may be used and
settings can be saved for each camera position / field of view setting.
If the camera is being used on the lightbox and stand provided by Skye, you can use the
3cm or 10cm black calibration disks in the Automatic Calibration mode, as described in
Chapter 6.1.1 below.
If you are analysing very large leaves, too big for the Skye lightbox, or very small leaves
where the field of view is less than 3cm across, then you can use the manual calibration
procedure described in Chapter 6.1.2.

6.1.1 Automatic Calibration Feature
1. Choose the File menu and Connect Camera. If you have more than one camera installed,
the following small window lists the cameras available. Highlight the camera you wish to
use and click OK.
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2. Choose the resolution of the image you would like to work with. Please note the higher
the resolution you choose, the slower the analysis may become with the greater number
of pixels to be analysed. Click OK.

3. Choose the File menu and Show Video (or use the shortcut F2 key) to display the live
video image.
4. Depending on the leaf size, place one or more typical leaves for this analysis session
under the leaf clamp on the light box (to flatten them) and adjust the zoom and focus
settings on the camera lens as necessary. Large leaves may have to be analysed
individually. Several smaller leaves can be analysed at once, depending how many
leaves you can fit into the camera’s field of view. It is important to make sure no leaves
are overlapping, else the software will count them as a single leaf.
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5. Now remove the leaves and calibrate the pixel size for these camera settings. It is
important to calibrate the pixel size each time you change any cameras settings,
especially the zoom (in or out). Place one the Calibration Disks under the camera – try the
10cm disk first. If you cannot see the whole disk in the live video window, use the 3cm disk.
DO NOT change any camera settings at this point.
6. Choose the File menu and Capture Image (or use the shortcut F1 key).

7. Use the Threshold function to instruct the software which part of the image contains the
calibrated disk. Untick the Red and Green boxes in the Primary Threshold window and
use the Blue bar to highlighted the disk in yellow on the right hand side of the window
as above.
8. Choose the Image menu and Set Scaling Factor. Choose the 10cm or 3cm disk as
appropriate. If you wish you can save the scaling factor for these camera settings.
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The system is now ready for taking measurements. As long as the camera settings are not
changed, this calibration procedure does not need to be performed again.

6.1.2 Manual Calibration Procedure
1.

Choose the File menu and Connect Camera. If you have more than one camera installed,
the following small window lists the cameras available. Highlight the camera you wish to
use and click OK.

2. Choose the resolution of the image you would like to work with. Please note the higher
the resolution you choose, the slower the analysis may become with the greater number
of pixels to be analysed. Click OK.
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3. Choose the File menu and Show Video (or use the shortcut F2 key) to display the live
video image.
4. Depending on the leaf size, place one or more typical leaves for this analysis session
under the leaf clamp on the light box (to flatten them) and adjust the zoom and focus
settings on the camera lens as necessary. Large leaves may have to be analysed
individually. Several smaller leaves can be analysed at once, depending how many
leaves you can fit into the camera’s field of view. It is important to make sure no leaves
are overlapping, else the software will count them as a single leaf.

5. Now remove the leaves and calibrate the pixel size for these camera settings. It is
important to calibrate the pixel size each time you change any cameras settings,
especially the zoom (in or out). Place one of the Calibration Disks under the camera – try
the 10cm disk first. If you cannot see the whole disk in the live video window, use the 3cm
disk. DO NOT change any camera settings at this point.
6. Place a rectangular object of known size under the camera. Squared graph paper is
ideal, mark a rectangle to fill the camera view as much as possible, as shown below.
7. Choose the File menu and Capture Image (or use the shortcut F1 key).
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8.

Calibrate the pixel size for this camera field of view as follows:
a) click Image and Set Scaling Factor. Choose Manually.
b) Select all four corners of the calibration ‘rectangle’, enter the dimensions and click OK.
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c) Enter the dimensions of the rectangle in the units you prefer, cm, mm or inches

d) Save this pixel size calibration for use whenever this camera setting is used again
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Enter a name for these settings which will enable you to remember the camera settings.

6.2 ANALYSIS
Repeat the following instructions to analyse each leaf / set of leaves in turn:
1. Choose the File menu and Capture Image (or use the shortcut F1 key).
2. Use the Threshold function to instruct the software which part of the image requires
analysing. Any pixel highlighted in yellow on the right hand side of the window will be
measured and analysed.
Set the total leaf threshold by dragging the cursor bars in the top Threshold window.
It is often easy to untick the boxes and then choose just one colour, e.g. green for a
green leaf.
Or the threshold of a brown leaf may be best set by choosing both red and green.
Move the bars to get the yellow right hand image the same size and shape as the
captured image on the left.
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3. The leaves are automatically analysed and the results shown in the lower left hand side
of the window.
4. In the example above there is clearly only one leaf being analysed, but the Results
window shows the Number of Leaves as 2. This is because the software is picking up
some specks of dust / dirt on the background which may only be a pixel or two in size
and not easily seen by eye.
To remove these specks choose the Tools menu and then Remove Small Objects.
Click to insert a tick in the box “Remove Small Objects”. The default size of 0.1 cm 2 will
usually remove any unwanted dust specks.

The results window now shows the Number Of Leaves correctly as 1.
5. If required, set the disease area threshold by dragging the cursor bars in the lower
Threshold window. Tick the box “Use Secondary Threshold” to activate the bars.
If the secondary area (e.g. diseased areas, insect damage, variegation etc) is a lighter
colour than the main leaf Primary Threshold colour, click the “Lighter Than” button.
If the secondary area is a darker colour than the main leaf Primary Threshold colour, click
the “Darker Than” button.
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Tick or untick the Red, Green or Blue boxes to choose the colours which will best highlight
the secondary area you wish to analyse. E.g. a brown spot may be best set using Red
and Green, or a black spot may be best set using blue.
Move the bars to highlight the required secondary areas in pale green on right hand
image.
(See example in Chapter 6 Instruction 5 for software screen views).
6. If you wish to enlarge or zoom either the original image or the thresholding window,
simply slide the central bar between the two windows to the right or left as required.
7. If necessary, choose the Image menu and Select Area of Interest to analyse only the
leaf and not the background. Drag a rectangle around the leaf to exclude the petiole /
stem if preferred.

8. Save results by clicking File and Save Results
9. Print / view the image and results by clicking File and Print Image Results
10. Repeat with fresh leaves as required. Choose the File menu and Show Video (or use the
shortcut F2 key) to display the live video image, and the File menu and Capture Image
(or use the shortcut F1 key) to capture.
The analysis of multiple leaves will be shown in the Session Results window.
Session results can be saved at any time, or reset for a fresh experiment by choosing the
Image menu and then Reset Session Results.
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7

ANALYSING SAVED IMAGES / PHOTOGRAPHS

It is important to remember to include a scaling object when taking photographs or saving
images for later analysis. A white piece of paper marked with a rectangle of known size is
ideal, as shown in the example below.
1.

Open the image or photograph by clicking File and Open and choosing your file
location
2. First calibrate the pixel size for this image:
a) click Image and Set Scaling Factor. Choose Manually.
b) Select all four corners of the calibration ‘rectangle’, enter the dimensions and click OK.
c) It is possible to save this pixel size calibration for use with another image later, but
this is not advised unless the camera settings, zoom and distance from the leaf are
identical and fixed for each photograph.

3. Use the Threshold function to instruct the software which part of the image requires
analysing. Any pixel highlighted in yellow on the right hand side of the window will be
measured and analysed.
Set the total leaf threshold by dragging the cursor bars in the top Threshold window.
It is often easy to untick the boxes and then choose just one colour, e.g. green for a
green leaf.
Or the threshold of a brown leaf may be best set by choosing both red and green.
Move the bars to get the yellow right hand image the same size and shape as the
captured image on the left.
4. If you wish to enlarge or zoom either the original image or the thresholding window,
simple slide the central bar between the two windows to the right or left as required.
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5. Set the disease area threshold by dragging the cursor bars in the lower Threshold
window. Tick the box “Use Secondary Threshold” to activate the bars.
If the secondary area (e.g. diseased areas, insect damage, variegation etc) is a lighter
colour than the main leaf Primary Threshold colour, click the “Lighter Than” button.
If the secondary area is a darker colour than the main leaf Primary Threshold colour, click
the “Darker Than” button.
Tick or untick the Red, Green or Blue boxes to choose the colours which will best highlight
the secondary area you wish to analyse. E.g. a brown spot may be best set using Red
and Green, or a black spot may be best using blue.
Move the bars to highlight the required secondary areas in pale green on right hand
image
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6. Click Image and Select Area of Interest to analyse only the leaf and not the background.
Drag a rectangle around the leaf to exclude the petiole / stem if preferred.

7. The leaves are automatically analysed and the results shown in lower left hand side of
the window
8. In the example above there is clearly only one leaf being analysed, but the Results
window shows the Number of Leaves as 3. This is because the software is picking up
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some specks of dust / dirt on the background which may only be a pixel or two in size
and not easily seen by eye.
To remove these specks choose the Tools menu and then Remove Small Objects.
Click to insert a tick in the box “Remove Small Objects”. The default size of 0.1 cm 2 will
usually remove any unwanted dust specks.

9. Save results by clicking File and Save Results
10. Print / view the image and results by clicking File and Print Image Results
11. Repeat with fresh images as required. The analysis of multiple leaves will be shown in the
Session Results window. Session results can be saved at any time, or reset for a fresh
experiment by choosing the Image menu and then Reset Session Results.
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8

SOFTWARE MENU DESCRIPTIONS

This chapter describes in detail the four menu options included in the SkyeLeafv2 software,
File, Image, Tools and Help, and also the analysis windows in the main view.

8.1

FILE MENU

OPEN
Open a photograph or image file to analyse.
Compatible file formats are .jpg, .bmp, .tif, .pcx,
.gif, .png,
CONNECT CAMERA
This menu option is not active unless one or more
digital USB video
cameras have been
installed on the PC. This
option allows the camera
to be chosen and
activated in the software.
CONNECT SCANNER
This menu option is not active unless a scanner
has been installed on the
PC. This option allows the
scanner to be chosen and activated in the software.
CAPTURE IMAGE
This menu option becomes active once a camera or scanner has been connected. For a
shortcut, simply press the F1 key, which also initiates the automatic analysis if enabled.
SHOW VIDEO
This menu option becomes active once a camera or scanner has been connected. For a
shortcut simply press the F2 key instantly switch to live video view.
DISCARD IMAGE RESULTS
This menu option discards the results of the current image and does not add them to the
session results. Useful if the leaves are not correctly placed under the camera, or the lighting
is not good etc.
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SAVE ORIGINAL IMAGE
The menu option saves the current original image as a .bmp file. This can be useful for saving
images from the live video camera systems.
SAVE MODIFIED IMAGE
The menu option saves the current modified or thresholded image as a .bmp file. This can be
useful for saving threshold settings.
SAVE RESULTS FILE
This menu option adds together the current image results plus the session results and saves
them as a single file. The file format can be chosen from the SkyeLeafv2 “.alr” (Analysed Leaf
Results which is XML format) for later opening again in SkyeLeafv2, or results can be
exported as a comma separated .csv file.
OPEN RESULTS FILE
This menu option opens a previously saved results file. You can continue to append results to
this file if you wish to continue the statistical analysis of many leaves.
PRINT IMAGE RESULTS
This menu option prints the results of the current image only, in a one page report format
including the original image plus the binary or analysed image. The user can add a title,
description and notes as required. The preview is shown on screen before printing. If the PC
has the appropriate printer installed the report can also be saved to file.
PRINT PREVIEW
This menu option previews the report before printing, and also allows the user to add a title,
description and notes as required.
EXIT
This option quits the SkyeLeafv2 program.
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8.2

IMAGE MENU
SET SCALING FACTOR
This menu option is used to
set the size of each pixel in the image to be analysed. It

leads to a sub menu with three choices as below:
a) Using 10cm calibrated Disk
The user must capture an image of an accurate 10cm disk,
preferably black or dark coloured, and set the threshold. Skye provides a 10cm calibration
disk with the software for this purpose. Ideally the black disk will nearly fill the image window
seen on the PC screen. The software will automatically measure the dimensions and aspect
ratio of the circular image and calculate the exact pixel size for these camera settings. It is
essential that the camera settings are not changed when using this scaling factor. If the
camera settings are changed, e.g. focus or zoom, then the calibration procedure must be
performed again for the new settings. Calibration settings can be saved with the user’s choice
of name or description.
b) Using 3cm calibrated Disk
The user must capture an image of an accurate 3cm disk, preferably black or dark coloured,
and set the threshold. Skye provides a 3cm calibration disk with the software for this purpose.
Ideally the black disk will nearly fill the image window seen on the PC screen. The software
will automatically measure the dimensions and aspect ratio of the circular image and
calculate the exact pixel size for these camera settings. It is essential that the camera settings
are not changed when using this scaling factor. If the camera settings are changed, e.g. focus
or zoom, then the calibration procedure must be performed again for the new settings.
Calibration settings can be saved with the user’s choice of name or description.
c) Manually
This menu option allows a manual calibration of pixel size, where the user clicks on the corners
of a rectangular object of known size (for example a square drawn on a piece of paper),
and enters the dimensions. This is useful when analysing previously saved image files, or if
the 10cm or 3cm disk is not the appropriate size for the camera field of view. Calibration
settings can be saved with the user’s choice of name or description.
LOAD SCALING FACTOR
This menu option allows the user to load a scaling factor
previously saved by the Set Scaling Factor menu.
RESET SESSION RESULTS
The accumulated session results, which may contain the
analyses of many leaves, is shown in the bottom left hand corner of the SkyeLeafv2 window.
If all the analysis windows are showing it may be necessary to scroll down to view the session
results. This menu option will reset the results and clear the display. The user is asked to
confirm the action before the results are cleared.
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SELECT AREA OF INTEREST
This menu option allows the user to exclude some areas of the image from being analysed.
This is useful if there are shadows at the edge of the image, or if the petiole or leaf stem
needs to be excluded from analysis. Place the mouse at one corner of the desired rectangle,
hold down the left mouse button and drag the rectangle to the required size. This option is
toggled on and off by choosing the menu or clicking on the icon. The menu shows a tick box
and the icon is highlighted in orange when the option is switched on.
RESET AREA OF INTEREST
This menu option clears the selected rectangular area of interest.
DISABLE IMAGE ANALYSIS
The current image is automatically reanalysed each time any changes are made to
threshold levels or calibrations and scaling. This can slow down the response of the program
if a high-resolution image (large number of pixels) is being analysed, especially while making
changes to the threshold settings. In this case it can be useful to disable and switch off the
automatic analysis function until all the necessary adjustments have been made. When
disabled, the menu shows a tick box and “Analysis Disabled” is shown in the Results for This
Image window. To re-enable automatic analysis, choose the Disable Image Analysis menu
option again to remove the tick box.

8.3

TOOLS MENU

PREFERRED UNITS
This menu option allows the user to choose between
measurement units of cm, mm or
inches. The tick box shows the
current choice.

REMOVE SMALL OBJECTS
This menu option allows the user to exclude any
specks of dust or dirt from the background of the
image, to prevent them being analysed, even
thought they may only be a pixel or two in size
and sometimes not easily seen by eye.
Click to insert a tick in the box “Remove Small
Objects”. The default size of 0.1 cm2 will usually
remove most unwanted dust specks or small pieces of plant matter. Click OK.
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COPY ORIGINAL IMAGE
This menu option places a copy of the original image being analysed on to the Clipboard,
from where it can be pasted into another software program if required, e.g. into a report.
COPY MODIFIED IMAGE
This menu option places a copy of the modified or thresholded image on to the Clipboard,
from where it can be pasted into another software program if required, e.g. into a report.

PASTE IMAGE
This menu option will paste an image from the Clipboard into SkyeLeafv2 for analysis.

8.4

HELP MENU
ABOUT
This menu brings up a window showing the SkyeLeafv2 software
version, and Skye Instruments Ltd contact details. Please do not
hesitate to contact Skye if you have any queries about this software.
Please check the Skye website for the location of Skye’s distributor in

your country.

8.5

PRIMARY THRESHOLD WINDOW
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This window enables the user to inform the software which part of the image is to be
analysed.
The window can be minimised by clicking the

box if required. Click

to restore.

To choose a colour to threshold, place a tick in one
or more of the R (red), G (green) or B (blue) boxes
to enable the slider bar.
Use the slider bars (or the right and left keyboard
keys) to highlight, in yellow, the area to be
analysed. This is shown in the modified or
thresholded image on the far right of the
SkyeLeafv2 window.

The background should be plain black. The software
will analyse only the yellow part of the image.
It is not always necessary to use all three RGB
colours, a plain green leaf may be easily
thresholded by using only the G green colour
plane.

8.6

SECONDARY THRESHOLD WINDOW

This optional feature enables the user to inform the software which part of the image
already selected by the Primary Threshold, is to be analysed a second time to show
diseased, damaged or variegated areas.
The window can be minimised by clicking the

box if not in use. Click
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To enable Secondary Area Analysis, place a tick in
the box marked Use Secondary Threshold.
To choose a colour to threshold, place a tick in one
or more of the R (red), G (green) or B (blue) boxes
to enable the slider bar.
If the secondary area (e.g. diseased areas,
insect damage, variegation etc) is a lighter
colour than the main leaf Primary Threshold
colour, click the “Lighter Than” button.
If the secondary area is a darker colour than
the main leaf Primary Threshold colour, click the
“Darker Than” button.
Use the slider bars (or the right and left keyboard
keys) to highlight in green the secondary area to be analysed. This is shown in the modified
or thresholded image on the far right of the SkyeLeafv2 window.
The background should be plain black. The software will
analyse the green part of the image as the secondary
area.
It is not always necessary to use all three RGB colours,
brown diseased area may be easily thresholded by using
only the R red colour plane.

8.7

ZOOM FEATURE

To enlarge either the original image or the modified, thresholded image, place the cursor
over the central bar dividing the two windows, click and hold the left mouse button, drag the
bar to the right or left as desired.
Dragging the centre bar to the right zooms in on the original image while making the
modified image smaller as shown below:
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Dragging the centre bar to the left zooms in on the modified image while making the original
image smaller as shown below:

8.8

RESULTS WINDOW FOR CURRENT IMAGE

This window appears on the left hand side, directly underneath the primary and secondary
thresholding windows.
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During analysis, this window displays the analysis
results of the current image, which could be of a
single leaf or of multiple leaves as shown here.
The number of leaves analysed is shown, plus the
total area, length, breadth and perimeter of all
leaves, the total area of all the secondary areas,
the maximum length and breadth of the largest
leaves.
If these measurements are required for each leaf
individually, then the leaves must be analysed singly and the results saved and reset each
time.

8.9 RESULTS WINDOW FOR SESSION
This window appears on the left hand side, directly underneath the Results for Current Image
window. It may be necessary to scroll down to view the Session Results, or alternatively
minimise one or both of the thresholding windows.
During analysis, this window displays the analysis
results of the current session, which includes the
cumulative results of one or many images of leaves.
The results from the current image are not added
to the session results until either the results are
saved, or a new image is analysed. This is to give
the user the opportunity to discard the current
image results if incorrect, for example if the leaves
are not correctly placed under the camera, or the
lighting is not good etc.

Once the results have been saved, the window
now shows all results including the current image.
Previous session results can be loaded (File and
Open Results File) if the session is to be continued
and more results included in the statistical analysis.
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APPENDIX 1 - TIPS AND SHORTCUTS
1.
2.

3.

4.

5.

6.

7.

SHOW LIVE VIDEO IMAGE
Simply press the F2 key to instantly switch to live video view. This is an easy one key
function especially useful when positioning a new leaf.
CAPTURE AN IMAGE
Simply press the F1 key to instantly capture an image from the camera or scanner (if
connected). This is an easy one key, which also initiates the automatic analysis if
enabled.
THRESHOLDING
Use the keyboard right and left arrow keys to make fine adjustments when thresholding.
It is often easy to untick the Red, Green, Blue boxes and then tick to choose just one
colour, e.g. green for a green leaf.
The threshold of a brown leaf or brown secondary disease areas may be best set by
choosing both red and green.
The secondary threshold of a black spot may be best set by choosing blue.
DISABLE ANALYSIS IF PC IS SLOW
If the PC is running slow, analysis can be disabled while the Threshold is being adjusted.
This prevents the software automatically analysing the image with each small adjustment,
especially useful if the image is high resolution with many pixels to analyse.
To Disable, choose the Image menu and Disable Image Analysis.
Don’t forget to enable again when ready!
CALIBRATION
The accuracy of the analysis depends highly on the user’s calibration of the pixel size
(using the Set Scaling Factor function).
In automatic mode, optimum accuracy is obtained by using the largest disk that can be
seen in the current live video window, i.e. use the 10cm disk unless a high zoom camera
setting prevents it.
In manual mode, optimum accuracy is obtained by using the largest square /
rectangular object which will fit into the current live video window.
ZOOM FEATURE
To enlarge either the original image or the modified, thresholded image, place the
cursor over the central bar dividing the two windows, click and hold the left mouse button,
drag the bar to the right or left as desired.
Dragging the centre bar to the right zooms in on the original image while making the
modified image smaller. Dragging the centre bar to the left zooms in on the modified
image while making the original image smaller.
ANALYSIS RESULTS OF INDIVIDUAL LEAVES
SkyeLeafv2 is designed for the fast, statistical measurement of large numbers of leaves. If
the analysis of each individual leaf is required, then each leaf must be analysed singly
and the results saved and reset each time.
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APPENDIX 2 - LIGHTING TIPS FOR GOOD IMAGES
When using a flatbed scanner the illumination of the objects is usually constant and not
adjustable. Most scanner software allow digital adjustment of brightness, contrast etc, but
beware of digitally changing the image too much in case this affects the dimensional
analysis. Be very careful never to adjust the aspect ratio of any images, as this will most
certainly introduce errors into the dimensional analysis.
The somewhat arbitrary scale of Threshold brightness can be adjusted up and down the
“real world” range of light intensities by altering the ‘F’ stop on a camera. Generally on a
video camera and light box system F8 to F11 gives reasonable results, but with different
lighting conditions, especially top light, different values will be found necessary. The best
results will be found by brief experimentation.
Having leaves pictured on a background that is very different in intensity to the leaves
themselves is the ideal. Care should be taken with the lighting to achieve this. For opaque
leaves, backlighting is ideal, as long as this is uniform across the entire width of the picture
(beware of cheap light boxes ). For semi-transparent leaves or opaque leaves where it is
desired to select areas by colour or grey level, then some top lighting is helpful (e.g.
sunshine when taking digital photographs in the field). Again, it is important to obtain even
lighting, and a mixture of low level back light, plus light from ‘angle poise’ lamps or similar, is
a common set-up.
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APPENDIX 3 - TROUBLESHOOTING
1.

2.

3.
4.
5.

6.
7.

I CAN’T CONNECT A CAMERA OR SCANNER
If the software is running in Demo Mode, these functions are disabled.
Does the camera / scanner have the DShow or DIRECT SHOW feature?
Does the camera / scanner operate normally using its own software?
If you are unable to connect the camera or scanner directly, you can use its own software
to capture the image required, then Open the saved image in Skyeleafv2 for analysis.
Always remember to include a scaled object, e.g. a square in the background, when
capturing the image.
I CAN’T SAVE THE RESULTS
If the software is running in Demo Mode, this function is disabled.
Are the results already saved?
Have the current results been discarded? In which case you must open or capture a new
image.
I CAN’T PRINT THE RESULTS
If the software is running in Demo Mode, this function is disabled.
Is there a printer installed on the PC? Does it work in other programmes?
I CAN’T MOVE THE SLIDER BARS TO CHANGE THE THRESHOLD
The slider bars can be enabled by ticking the box to the left of each bar.
I’M HAVING PROBLEMS WITH THRESHOLDING THE IMAGE
Try unticking and disabling two colours and trying to threshold the image with just one
colour at first, e.g. G Green for a green leaf or B Blue for the Calibration Disk. Then
introduce a second colour and then a third if necessary. Often, for plain leaves just one
colour is sufficient.
I’M HAVING PROBLEMS WITH THE SET AREA OF INTEREST FUNCTION
This function is toggled on and off by clicking on the menu item or icon. You do not need
to click the option to enable it each time it is used, it remains on until turned off.
SKYELEAFv2 IS RUNNING VERY SLOWLY
If the software is running slowly, analysis can be disabled while the Threshold is being
adjusted. This prevents the software automatically analysing the image with each small
adjustment, especially useful if the image is high resolution with many pixels to analyse.
To Disable, choose the Image menu and Disable Image Analysis.
Don’t forget to enable again when ready!
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SKYELEAFv2 SYSTEM SPECIFICATIONS
PC REQUIREMENTS:
 PC running Windows XP Professional (Service Pack 2 or above) or Windows Vista
Professional or Windows 7 Professional
 Current Windows upgrades installed, including the .NET Framework 3.5 program
installation feature
 Spare USB port for video camera or scanner (if required)
 NOTE – the software is designed to operate faster if the PC has a dual or quad core
microprocessor
IMAGE CAPTURE REQUIREMENTS
 Any or all of the following may be used:
 'Live’ video camera system, or laboratory system – a USB video camera with drivers fully
installed. The camera must have DShow or Direct Show, a feature which can be accessed
directly from the SkyeLeafv2 software, without translation required from the camera
manufacturer’s own software.
 Flatbed scanner system - USB scanner with drivers fully installed
 Digital camera with PC cable or memory card reader to transfer photographs or images
to the PC
SYSTEM OPTIONS
Choice of three systems:
 Stand alone software for the analysis of saved image files.
Post analysis of leaf images taken using a standard digital camera in the field. Files can be
analysed in situ on a laptop PC or can be analysed later in the laboratory or office. It is
important to remember to include a scaling object in each photograph.
 Laboratory system using a PC with light box and USB video camera
Although this is a destructive method of analysis, it gives the most flexible approach for
analysis of a wide range of leaf sizes, colours and varieties. Lighting of leaves to be
analysed is fully adjustable, allowing easy determination of different colours, shades and
diseased or damaged areas on the leaves.
 PC system with a flatbed scanner.
A standard office flatbed USB scanner can be used to capture images directly into
SkyeLeafv2 for analysis.
SOFTWARE FEATURES:
 SkyeLeafv2 makes fast and accurate measurements of leaf images, plus accumulated
measurements of whole sessions of an unlimited number of images. One leaf image can
contain single or multiple leaves, as appropriate.
 SkyeLeafv2 runs in demo mode for 15 minutes (unlimited runs) with some features
disabled until the software is purchased and unlocked
 Automatic measurements are made of number of leaves, the total area of all leaves, the
total length, breadth and perimeter of all leaves, the total area of all the secondary
(diseased / damaged areas), the maximum length and breadth of the largest leaf.
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 The user defines the part of the image to be analysed by using a Threshold function of








intensity in the Red, Green and Blue light planes. Single or combinations of light colour
planes can be chosen.
Secondary threshold for diseased / damaged areas can be set separately as required.
Dual view window shows original leaf image and the threshold settings simultaneously.
Easy threshold adjustment using slider bars in main window.
Automatic pixel size calibration feature (for live digital camera options only). SkyeLeafv2
scales the size and aspect ratio of the pixels in the current image with the use of a
Calibration Disk of 3cm or 10cm, provided with each copy of the software.
Manual calibration feature for saved images / photographs, or for live images of very
large or very small leaves.
Remove small objects function to eliminate errors due to soil / leaf debris included in the
leaf image
Print report feature includes original and threshold images, results and user notes
Results can be saved in XML or CSV formats, as single files or session results. Files can be
imported to continue a session at a later time.
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SKYELEAFv2 SOFTWARE LICENCE AGREEMENT
Terms & Conditions
1.

Skye Instruments (hereinafter referred to as “the Owner”) hereby grants to you the
user, and you accept, for yourself or on behalf of your organisation, a non-exclusive,
non-transferable licence to use the enclosed disk, Program Documentation and any
related materials (hereinafter referred to as “the Software”) on the terms and
conditions set out herein.

2.

The Software is the Owner’s proprietary product and is protected by Copyright law.
The Owner reserves all rights of ownership and copyright in the Software as recorded
on the diskette, and all subsequent copies thereof. You the user own only the
diskette on which the Software is recorded.

3.

The Software is distributed on the basis that they shall not be copied for further
distribution or resale without the written permission of the Owner.

4.

You may:

5.

4.1

Install and use the Software on a computer

4.2

Transfer the Software onto another computer

4.3

Make full or partial copies of the Software for backup and archive purposes
only, provided you label such copies clearly with our name, the name of the
program and the date of this licence.

4.4

Transfer the Software and the licence permanently to another party but only
if you obtain our prior written approval and provided the other party agrees
to these terms and conditions. Any such transfer terminates your licence
agreement.

You may not:
5.1

Transfer, assign, rent, lease, sub-licence, sell, give or otherwise dispose of this
Software except as stated in these Terms and Conditions.

5.2

Reverse compile, disassemble, or otherwise reverse engineer the whole or
part of the Software.

5.3

Modify, adapt or translate the Software in any way.

5.4

Merge the whole or part of the Software with any other software other than
that strictly required by the operating system stated in these Terms and
Conditions.
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6.

7.

5.5

Reproduce, distribute or alter the Software documentation.

5.6

Make the Software freely available to another party(s)

Your responsibilities:
6.1

You are responsible for installing and commissioning the Software onto your
computer system(s) unless the Owner has agreed in writing to do so.

6.2

You must ensure that proper security precautions are followed to secure
backup copies of the Software, and that an effective control is kept on the
number of copies of the Software.

6.3

You must train the staff that run this Software to understand its purpose,
operations and limitations. You are responsible for how you use the
Software.

6.4

You are responsible for the interpretation of the results produced by the
Software.

6.5

You must treat this Software and its documentation as confidential. You must
not disclose any part of it to another party without the Owners permission.

Term
7.1

You are licensed to use the Software indefinitely.

7.2

You may terminate your licence and this Agreement at any time by returning
it to us together with the original media and user documentation of the
Software.

7.3

This licence will terminate immediately if you fail to comply with any term or
condition of this Agreement.

In the event of any termination you must destroy all full or partial copies of the
Software resident on your computer system(s) in any form and you agree to provide
the Owner on request a written certificate of such destruction.
8.

Warranty
The Owner warrants that it has the right to licence the Software and that for a period
of ninety (90) days from the date of purchase the diskette on which the Software is
supplied will be free from all defects. If a CD of the Software is defective the Owner
will replace it at no charge provided that the defective item is returned to the Owner
within ninety (90) days from the date of purchase.
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The Owner warrants that the Software will perform substantially in accordance with
the accompanying documentation.
EXCEPT FOR THE LIMITED WARRANTY DESCRIBED IN THIS PARAGRAPH THERE ARE NO
WARRANTIES EITHER EXPRESSED OR IMPLIED BY THIS AGREEMENT. NO WARRANTY
IS GIVEN AS TO THE COMPLETENESS OR ACCURACY OF THE SOFTWARE NOR THAT
IT IS ERROR-FREE OR OF A SATISFACTORY QUALITY OR APPEAR PRECISELY AS
DESCRIBED IN ANY DOCUMENTATION IN RESPECT OF THE SOFTWARE. ALL OTHER
SUCH WARRANTIES ARE EXPRESSLY DISCLAIMED.
9.

Liability
You shall use the Software at your own risk and you agree that regardless of the
form of any claim you have, the liability of the Owner and their authorised distributor
shall not exceed the value of the Licence fee you have paid for the Software.
THE OWNER AND THEIR AUTHORISED DISTRIBUTOR ACCEPT NO LIABILITY FOR ANY
LOSS OR DAMAGE, LOSS OF PROFIT, LOSS OF CONTRACTS, ANTICIPATED SAVINGS
OR ANY OTHER DIRECT OR INDIRECT CONSEQUENTIAL LOSS OR DAMAGES
HOWSOEVER CAUSED EXCEPT THAT WHICH IS UNLAWFUL TO EXCLUDE.
Notwithstanding the above, nothing herein shall exclude any liability for death or
personal injury which arises as a result of the negligence of the Owner and/or their
authorised distributor, their employees, servants or authorised representatives.

10.

General
Should any of the provisions of this Licence Agreement be ruled invalid under any
law or Act of Parliament, they shall be deemed modified or omitted only to the
extent necessary to render them valid and the remainder of the Agreement shall be
upheld.

11.

Law
This Agreement shall be governed by and construed in accordance with the law of
England and Wales and shall be subject to the jurisdiction of the Courts of England.

12.

Upgrades
Upgrades to the Software will be chargeable.
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